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Goals

You should understand the fundamental operation of a radio telescope and recognize how it is similar to, and different from, an optical telescope. You should understand how astronomers, using radio telescopes, recognize the distinctive properties of pulsars. You should understand what is meant by interstellar dispersion, and how it enables us to measure the distances to pulsars.

Objectives

If you learn to.......

Use a simulated radio telescope equipped with a multi-channel receiver. Operate the controls of the receiver to obtain the best display of pulsar signals. Record data from these receivers.
Analyze the data to determine properties of the pulsars such as periods, signal strengths at different frequencies, pulse arrival times, relative strengths of the signals.

Understand how the differences in arrival times of radio pulses at different frequencies tell us the distance the pulses have traveled.

You should be able to.....

Understand the basic operation and characteristics of a radio telescope.

Compare the periods of different pulsars, and understand the range of periods we find for pulsars.

Understand how a pulsar’s signal strength depends on frequency. Determine the distance of several pulsars.

[bookmark: Useful_Terms_You_Should_Review_Using_You]Useful Terms You Should Review Using Your Textbook

	Crab Nebula
	interstellar medium
	pulsar
	frequency

	Declination
	Julian Date
	radio telescope
	parsecs

	dispersion
	magnetic field
	radio waves
	period

	electromagnetic spectrum
	neutron star
	resolution
	speed of light

	electromagnetic radiation
	Universal Time (UT)
	Right Ascension
	




Background: Neutron Stars and Pulsars

Many of the most massive stars, astronomers believe, end their lives as neutron stars. These are bizarre objects so compressed that they consist entirely of neutrons, with so little space between them that a star containing the mass of our sun occupies a sphere no larger than about 10 km. in diameter, roughly the size of Manhattan Island. Such objects, one would think, would be extremely hard, if not impossible, to detect. Their surface areas would be several billion times smaller than the sun, and they would emit so little energy (unless they were impossibly hot) that they could not be seen over interstellar distances.

Astronomers were therefore quite surprised to discover short, regular bursts of radio radiation coming from neutron stars—in fact it took them a while before they realized what it was they were seeing. The objects they discovered were called pulsars, which is short for “pulsating radio sources.”

The discovery of pulsars was made quite by accident. In 1967, Jocelyn Bell, who working for her Ph.D. under Anthony Hewish in Cambridge, England, was conducting a survey of the heavens with a new radio telescope that was designed specifically to look for rapid variations in the strengths of signals from distant objects. The signals from these objects varied rapidly in a random fashion due to random motions in the interstellar gas they pass through on their way to earth, just as stars twinkle randomly due to motions of air in the earth’s atmosphere.

[bookmark: Radio_Astronomy_of_Pulsars_]Bell was surprised one evening in November 1967 to discover a signal that varied regularly and systematically, not in a random fashion. It consisted of what looked like an endless series of short bursts of radio waves, evenly spaced precisely 1.33720113 seconds apart. (See adjacent figure, which shows the chart on which Bell first discovered the pulses.) The pulses were so regular, and so unlike natural signals, that, for a while, Bell and Hewish tried to find some artificial source of radiation—like a radar set or home appliance—that was producing the regular interference. It soon became clear that the regular pulses moved across the sky like stars, and so they must be coming from space. The astronomers even entertained the idea that they were coming from “Little Green Men” who were signaling to the earth. But when three more pulsating sources were discovered with different periods (all around a second in length) and signal strengths in different parts of the sky, it became clear that these “pulsars” were some sort of natural phenomenon. When Bell and Hewish and their collaborators published their discovery, in February 1968, they suggested that the pulses came from a very small object—such as a neutron star—because only an object that small could vary its structure or orientation as fast as once a second.
	
[image: ]

Figure 1:  Chart on which Jocelyn Bell discovered her first pulsar


It was only about six months after their discovery that theoreticians came up with an explanation for the strange pulses: they were indeed coming from rapidly spinning, highly magnetic, neutron stars. Tommy Gold of Cornell University was the first to set down this idea, and, though many details have been filled in over the years, the basic idea remains unchanged.

We would expect neutron stars to be spinning rapidly since they form from normal stars, which are rotating. When a star shrinks, like a skater drawing her arms closer to her body, the star spins faster (according to a principle called conservation of angular momentum). Since neutron stars are about 100,000 times smaller than normal stars, they should spin 100,000 times faster than a normal star. Our sun spins once very 30 days, so we would expect a neutron star to spin about once a second. A neutron star should also have a very strong magnetic field, magnified in strength by several tens of billions over that of a normal star—because the shrunken surface area of the star concentrates the field. The magnetic field, in a pulsar, is tilted at an angle to the axis of rotation of the star (see Figures 2a and 2b).

[image: ]Now according to this model the rapidly spinning, highly magnetic neutron traps electrons and accelerates them to high speeds. The fast-moving electrons emit strong radio waves, which are beamed out like a lighthouse in two directions, aligned with the magnetic field axis of the neutron star. As the star rotates, the beams sweep out around the sky, and every time one of the beams crosses our line of sight (basically once per rotation of the star), we see a pulse of radio waves, just like a sailor sees a pulse of light from the rotating beacon of a lighthouse.








Figure 2A
The pulse is “on.”
The Earth receives the radio waves.














[image: ]Figure 2B
The pulse is “off.”
The Earth does not detect the radio waves.


Today over a thousand pulsars have been discovered, and we know much more about them than we did 1967. The pulsars seem to be concentrated toward the plane of the Milky Way galaxy, and lie at distances of several thousand parsecs away from us. This is what we’d expect if they are the end products of the evolution of massive stars, since massive stars are formed preferentially in the spiral arms which lie in the plane of our galaxy. Except for a few very fast “millisecond” pulsars, the periods of pulsars range from about 1/30th of a second to several seconds. The periods of most pulsars increase by a small amount each year—a consequence of the fact that as they radiate radio waves, they lose rotational energy. Because of this, we expect that a pulsar will slow down and fade as it ages, dropping from visibility about a million years after it is formed. The faster pulsars thus are the youngest pulsars (except for the “millisecond pulsars, a separate type of pulsars, which appear to have been spun up and revitalized by interactions with nearby companion.)

[image: ]

Figure 3: Typical Pulsar Signal
To an observer, a pulsar appears as a signal in a radio telescope; the signal can be picked up over a broad band of frequencies on the dial (In this exercise, you can tune the receiver from 400 to 1400 MHz). The signal is characterized by short bursts of radio energy separated by regular gaps. (See FIGURE 3). Since the period of a pulsar is just the length of time it takes for the star to rotate, the period is the same no matter what frequency your radio telescope is tuned to. But, as you will see in this lab, the signal appears weaker at higher frequencies. The pulses also arrive earlier at higher frequencies, due the fact that radio waves of higher frequency travel faster through the interstellar medium, a phenomenon called interstellar dispersion. Astronomers exploit the phenomenon of dispersion, as described later in the text of this exercise, to determine the distance to pulsars.

In this lab, we will learn how to operate a simple radio telescope, and we’ll use it to investigate the periods, signal strengths, and distances of several representative pulsars.

Operating the Computer

First, some definitions:

press	Push the left mouse button down (unless another button is specified)

release	Release the mouse button.

click	Quickly press and release the mouse button

double click	Quickly press and release the mouse button twice.

click and drag	Press and hold the mouse button. Select a new location using the mouse, then release.

menu bar	Strip across the top of screen; if you click and highlight the entry you can reveal a series of choices to make the program act as you wish.

scroll bar	Strip at side of screen with a “slider” that can be dragged up and down to scroll a window through a series of entries.


Starting the program

Your computer should be turned on and running Windows. Your instructor will tell you how to start the VIREO program.

1. Go to File on the menu bar at the top of that window, click on it, and select Login.
· Fill in the form that appears with your name (and your partner’s name, if applicable). Do not use punctuation marks.
· Press tab after entering each name, or click in each student block to enter the next name.
· Enter the Laboratory table number or letter if it is not already filled in for you. You can change and edit your entries by clicking in the appropriate field and making your changes.
· When all the information has been entered to your satisfaction, click OK to continue, and click yes when asked if you are finished logging in.

2. To initialize the software for this exercise, select File > Run > Radio Astronomy of Pulsars. 


Procedure

The lab consists of the following parts

1. Familiarization with the radio telescope.

2. Observation of a pulsar with a single-channel radio receiver to learn about the operation of the receiver and the appearance of the radio signals from a pulsar at various receiver settings.

3. Determination of the pulse periods of several pulsars.

4. Measurement of the distance of pulsars using the delay in arrival times of pulses at different frequencies due to interstellar dispersion.

5. Determine the distance of a pulsar using the techniques you have just learned.

Part 1: The Radio Telescope

1. Select Telescopes > Radio then open the telescope control panel by clicking on the button.
· The window should now show you the control panel for the CLEA radio telescope. The main window shows the telescope itself, a large steerable dish, which acts as the antenna to collect radio waves and send them to your receiver.
· The Universal Time (UT) and the local sidereal time for your location are shown in the large digital displays on the left. (See FIGURE 4 shown on page 8)
· The coordinates at which the telescope is pointed, Right Ascension (RA) and Declination (Dec), are shown in the large displays at the bottom. (See FIGURE 4 shown on page 8)
· A yellow square shows you where the telescope is pointed.


2. The telescope has a tracking motor designed to keep it pointed at the same spot in the heavens as the earth turns. Right now the motor is off, and, even if you are not moving the telescope with the N-E-S-W buttons, you will see the Right Ascension display changing, because the rotating earth is causing the telescope to sweep the heavens. You should turn on the tracking motor to remedy this. Just below the time displays on the left hand side of the screen is a button labeled Tracking. If you click on it, you will see the word on appear next to the button, and you will notice that the Right Ascension display stops changing. The telescope will now track any object it is pointed at.

3. You can now steer the telescope around the sky by clicking and holding down the N-E-S-W buttons at the left side of the window. Try it, and watch the square move, showing that the telescope is moving around the sky.
· The coordinate readouts will also move.
· You can change the pointing speed of the telescope by resetting the slew rate button at the lower left. Try setting it to 100, and see how much faster you can move the telescope around the sky.

4. You can move the telescope in two other ways:
· by selecting Slew > Set Coordinates
· by selecting objects from the Slew > Hot List menu. We will use the Hot List in this exercise because it is so convenient.

5. You are now ready to receive signals from your first pulsar.
[image: ]                 Figure 4: Sky View
Part 2: Observation of a Pulsar with a Single-Channel Radio Receiver

Let’s begin by familiarizing yourself with the receiver and general properties of pulsars. In this part of the exercise you will point the telescope at a moderately strong pulsar and, using a radio receiver with a graphic display, look at the pulsing radio signal to get some idea of its overall characteristics. The radio waves      we receive from pulsars are characterized by sharp pulses of short duration, very steady in their           period of repetition, with periods of as short as a few hundredths of a second up to several seconds. The strength of individual pulses varies a bit, in a random fashion, as we shall see, but the overall strength of the signals depends most strongly on the frequency at which you observe them. Our radio receiver can be tuned to any frequency between 400 and 1400 megahertz (MHz), and we will use this feature to see, qualitatively, how a pulsar’s signal strength changes with frequency.

1. We want to point our radio telescope to pulsar 0628-28. To move the telescope to the proper coordinates, we will use Slew > Hot List. Double click on the pulsar desired, 0628-08 (the name is in the leftmost column).


· After asking you for verification, the telescope will begin to move. You’ll see the square on the sky map move, and the coordinate displays change, until the telescope is pointing at the object.
· Write down, in the space provided, the Right Ascension and Declination you are pointing to: RA	Dec  	
2. Now that the big dish antenna is pointed in the right direction, you want to turn on your radio receiver.
Click on the Receiver button in the upper right of the telescope control window.
· A rectangular window will open which has the controls for your receiver on the right, and a graphic display of the signal strength versus time on the left. (See FIGURE 5)
· The frequency the receiver is set to is displayed in the window near the upper right. It is currently set to 600 MHz, and you should leave it there. Later, when you want to change frequency, there are buttons next to it to tune the receiver to different frequencies. Fine tuning can be accomplished by changing the Freq. Incr. (frequency increment), button to its right in conjunction with the main tuning button. There are also buttons to control the horizontal and vertical scale of the graphic display.

[image: ]
Figure 5: Main Receiver Window

3. Let’s look at what the pulsar signal looks like. Click on the Mode button to start the receiver. You’ll see a graphical trace begin at the left of the screen, tracing out the signal strength versus time on the graph. It looks like a random jiggle, which is the background static, with an occasional brief rise in signal strength, which is the pulsar signal. (If your computer is equipped with sound, you can also hear what the signal would sound like if you converted the signal to sound, like you do when listening to a radio station). Note how regularly the signal repeats.

4. Click on the Mode switch again to turn off the receiver. Note that it completes one scan of the screen before it stops.

5. Let’s see what the other controls do. Start the receiver again. Now watch the trace as you change the Vertical Gain control by clicking on the up and down buttons. This is like the volume control on a radio, except it only controls the graphic display.
· When the gain is high (you can turn it up to 8), the graphic trace is bigger, both the background and the pulsar signal are magnified.
· When the gain is low (you can turn it down to 0.25) you can barely see the pulsar. You’ll find that the best setting is one where the pulses are high, but don’t rise above the top of the display.
· Write down the gain setting you think is best here:	. The setting will vary from pulsar to pulsar, and also is dependent on how you have set the Horz Sec control. (It should be set at 4, right now).

6. Let’s try changing the horizontal scale (Horz Secs). You can only set this control when the receiver is off. Click the Mode switch off, and when the trace stops, reset Horz Sec to 2. This will make the graphic trace take 2 seconds to sweep across the screen. Start the receiver again.
· You will see the trace race across the screen faster.


· You may also note that the signal seems weaker, because your receiver is spending less time collecting radio waves before it displays them on the screen. (Astronomers would say the “integration time” is shorter.)

7. Try setting the Horz Sec to 0.5 sec. The pulses seem so wide you may have trouble distinguishing them, and you may have to raise the vertical gain to make them out at all.

8. Change the Horz Sec to 16. The trace pokes across the screen, and because the receiver is collecting more signal at a slower pace, the signals seem stronger. You will have to turn down the gain to avoid having your pulse peaks out of range of the screen.

9. Now let’s measure the period of the pulsar. Set the vertical gain to 4 and the horizontal seconds to 4, and make sure the frequency of the receiver is 600 MHz. Start the receiver. Let it run for a few seconds to see the pulses, then turn it off again. When the trace stops moving, you can measure the time between pulses on the screen.
· The computer has measuring cursors to aid you in doing this. Holding down the left mouse button produces a vertical blue line on the screen which you can move as you hold down the button. Center it in the middle of one of the pulses near the left side of the screen. Note the blue numbers on the screen that tell you the time in seconds at which the pulse arrived.
· You want to measure the time of arrival of the next pulse (time increases to the right)—so you can get another line, a white one, to appear by holding down the right mouse button. Position it over the next pulse. You can read this time from numbers on the screen, too. Now record the time of arrival of both pulses on the table below. The difference between these is the period of the pulsar!
[image: ]
Figure 6: Main Receiver Window

· Time of First Pulse (T 1 )  	 sec

· Time of Next Pulse (T 2 ) 	 sec

· Period of Pulsar (T 2 -T 1 )  	 sec

10. A more precise way of measuring the period is to measure the time elapsed between several pulses and then divide by the number of periods that have elapsed.
· Set the horizontal seconds control to 16, turn down the gain a notch or two, and turn on the receiver again so that you can see many pulses on one scan. Measure the time it takes for 10 periods, and use this to calculate the period of the pulsar. See if this gives you the same value. Record your measurements below.

· Time of first Pulse ( T 0 )  	 sec

· Time 10 Periods later (T 10 )  	 sec
(Note that this is the 11th  pulse)

· Period of Pulsar =(T 10 -T 0 )/10  	 sec

11. Now let’s look at the relationship between the pulsar period and the frequency. You can tune the receiver to different frequencies and, using whichever one of these methods is most convenient, measure the period at different frequencies. Since the signal strength changes with frequency, you may have to adjust the vertical gain or the horizontal seconds controls to see the pulses clearly at each frequency.

Fill in the following table, which will work whatever method you use:
	
Frequency
	Time of First Pulse (sec)
	Time of Last Pulse (sec)
	Number of Periods
	Period of Pulsar
(sec)

	400 MHz
	
	
	
	

	600 MHz
	
	
	
	

	800 MHz
	
	
	
	

	1000 MHz
	
	
	
	

	1200 MHz
	
	
	
	

	1400 MHz
	
	
	
	



12. From what you have measured, briefly state how the period of the pulsar depends on the frequency:
                                                                                                                                                           

13. How does the pulsar signal strength depend on frequency? Clearly it does, since you have to reset the vertical gain at different frequencies. But to see how it changes in a more systematic fashion, let’s keep those controls set—for example, 1 for the vertical gain and 16 for the horizontal seconds. Then look at the signal at various frequencies from 1400 MHz back down to 400 MHz. Answer the following questions.
· The pulsar signal is stronger at	(lower/higher) frequencies.
· If I am hunting for pulsars in the sky, or want to measure the period of a pulsar I’ve never investigated before, the best frequency to tune my receiver would be	MHz.
· The reason for this choice is:







14. You can now click the x at the upper right of the receiver window to close the receiver and return to the telescope control, where you will investigate several other pulsars.

Part 3: The Periods of Different Pulsars

Now we will look at the periods of different pulsars. The short periods of the pulsar we have just measured is remarkable, especially when you consider that the period is the length of time it takes for the star to rotate once. Imagine an object as massive as our sun rotating once a second! The pulses of each pulsar are distinctive, both in period and in strength.

1. Knowing how to steer the instrument and use the receiver, measure the periods of the following pulsars that are listed in the hot list. Also keep an eye on the signal strength. Try to rank the pulsars in order of signal strength, with the strongest pulsar labeled 1, the next strongest, 2, etc. Record your data in the table.



	
Pulsar
	
Frequency
	
Starting Pulse time
	
Last Pulse time
	Number of Periods Elapsed
	
Period
	
Relative Strength

	
2154+40
	
	
	
	
	
	

	
0740-28
	
	
	
	
	
	

	0531+21 (Crab
Nebula Pulsar)
	
	
	
	
	
	



2. Generally speaking, the rotation of a pulsar slows down as it ages. Based on your measurements, rank the four pulsars you have measured, 0628-28, 2154+40, 0740-28, and 0531+21, in order of age, from the youngest to the oldest:
YOUNGEST   	  2
3
OLDEST	 	

Part 4: Measurement of the Distance of Pulsars Using Dispersion

A. Method

Most pulsars can’t be seen with optical telescopes, so we can’t use their absolute magnitudes to determine distance. How can we determine their distance then? One powerful method is to use the phenomenon of dispersion. All forms of electromagnetic radiation, including radio waves, travel at the same speed in a vacuum. This speed is speed of light

c = 3 x 108  meters/sec
However, interstellar space is not quite a vacuum. On the average the interstellar medium consists of a few atoms and a few free electrons in each cubic centimeter. It isn’t much, but it’s enough to slow down electromagnetic waves slightly. The lower the frequency, the slower the radiation travels. This means that, though the effect is small, pulses from a pulsar arrive a fraction of a second earlier at higher frequencies than at lower frequencies, because the higher frequency pulses travel faster through the interstellar medium. You’ll be able to see this easily using our radio telescope, since you can receive signals at up to three wavelengths simultaneously, and can compare the arrival times on the three graphic displays.

By measuring the times of arrival of pulses from the same pulsar at different frequencies you can determine the distance to the pulsar, as long as you know the speed of radio waves through the interstellar medium at different frequencies. We do in fact know how frequency affects the speed of electromagnetic radiation from the theory of electromagnetism developed over 100 years ago.

B. An Example from the Everyday World

In a simplified case unrelated to electromagnetism, we can look at how arrival time helps determine distance traveled by two athletes running a race . Suppose we have two runners (A and B) who are racing each other. Runner A runs a steady 5 kilometers an hour; and Runner B runs a steady 10 kilometers an hour.


We do not know ahead of time HOW FAR they are running, but we do know their speeds and we do know that they both start running at the same time. It’s easy to see that the difference in the times they cross the finish line depends on the length of the race. (See FIGURE 7). Suppose the course is 10 kilometers long.
Runner A finishes in two hours. Runner B finishes in 1 hour. So there is a 1 hour difference between them if the course is 10 kilometers long. If the course is 20 kilometers long, Runner A finishes in four hours, and Runner B finishes in 2 hours, or a 2 hour time difference between the two. You can, in principle, determine the length of the race from the difference in the finish times.

[image: ]

Figure 7: Illustration of the example


We can represent this mathematically by deriving a formula where the length of time it takes for runner A to finish the length of the course L is divided by her speed:

[bookmark: TA_=_L/_Va______]TA = L/ Va

Similarly the length of time it takes for runner B to finish is the length of the course divided by his speed:

TB = L/Vb



So the difference in times can be described as

TB – TA = L/Vb – L/Va

or (factoring out L from both terms on the right)

TB – TA = L (1/Vb – 1/Va)

And solving for L

[bookmark: L_=_____TB_–_TA_____]L =	TB – TA
  (1/Vb – 1/Va)

Try the equation using the following numbers taken from our above example:
Va = 5 km/hr Vb = 10 km/hr
TB  - TA = 1 hour, or 2 hours,
and you’ll see you get L = 10 km for a 1 hour difference, and L= 20 km for a 2 hr difference.

C. The Dispersion Formula for the Interstellar Medium

The laws of physics enable us to calculate the speed of electromagnetic radiation in the interstellar medium and to derive a formula similar to the one above for the distance traveled in terms of the delay in arrival between radio pulses received at different frequencies. Lower frequencies travel slower, arriving later. In addition, the number of charged particles—the electron density— of the interstellar medium affects the delay, increasing it if the density is higher. For these radio frequencies, the delay time of electromagnetic radiation is proportional to the electron density divided by the square of the frequency, and theory yields the equation:
1/v2 - 1/v1 =  4150 * ne ((1/f2)2 – (1/f1)2)
For the purposes of this lab, we will assume that the interstellar electron density is uniform and has a value of 0.03 electrons/cm3, a number derived from observations of pulsars at distances known using other methods. Therefore,

1/v2 – 1/v1 =  124.5 ((1/f2)2 – (1/f1)2)

Using this assumption, and noting further that T1 is the time of arrival (in seconds) of a pulse from a pulsar at radio frequency f1 (in MHz), and T2 is the time of arrival of the same pulse at frequency f2, then the distance, D, to the pulsar (in parsecs) is given by the same sort of equation we derived above, with the speed of electromagnetic radiation substituted for the speed of the runners!


[bookmark: D_=_______________T2-T1_________________][bookmark: ____124.5_((1/f2)2_–_(1/f1)2)_]D =               T2 - T1                  
124.5 ((1/f2)2 – (1/f1)2)




So in order to determine the distance of a pulsar, we simply need to measure the time of arrival of a pulse from a pulsar at two different frequencies. We’ll do that in the next part for two of the pulsars we’ve already looked at.

D. Measuring The Distances Of Pulsars

1. Using the control panel of your radio telescope, go to pulsar 0628-28. Open the radio receiver window, set the vertical gain for 4 and the horizontal seconds for 4, and tune the receiver to 400 MHz. Then turn on the receiver just to make sure you are getting strong pulses.

2. Stop the receiver now. Let’s add a second receiver. Click on the add channel button and a second receiver display should appear below the first, aligned with it. Set the vertical, horizontal and frequency controls to the same values as the first receiver, a frequency of 400 MHz, 4 for the vertical gain and 4 for the horizontal secs.

3. Set the Freq Incr. button on the lower receiver to 10 MHz, (making it possible to tune the second receiver 10 MHz at time).

4. Turn on the receivers by clicking the mode button located on the top receiver. Both receivers will start recording.
· Because they are both receiving the same signal at the same frequency, the two traces should be exactly the same (except, perhaps for a slight random noise in each separate receiver).

How does the arrival times of pulses depend on frequency? Let’s find out.

5. Turn on the channels by clicking the mode button in the first channel. While the receivers are running, tune the second receiver to 410 MHz . Do you notice a difference in the arrival times of the higher frequency pulse? Watch for a few seconds.

6. Tune the receiver up to 420 MHz, then 430 MHz. Is the behavior becoming clearer?
· Tune the second receiver slowly in 10 MHz increments up to 600 MHz, pausing now and then to watch the scans.

What can you say about the arrival times of pulses at higher frequencies? Do they arrive earlier or later than the pulses at lower frequencies? Write your conclusion as a brief statement below.

                                                                                                                                                        

                                                                                                                                                        

7. Turn off the receivers with the mode button. Now open up a third receiver using the add channel button and tune it to 800 MHz, and set both the vertical gain and horizontal gain to 4.

8. Turn on the mode button in the first receiver and watch the traces on the three receivers.
Is the behavior you see in accord with what you now understand about the arrival times of the pulses at different wavelengths? Explain.

                                                                                                                                                        

                                                                                                                                                        

E. Measuring the Arrival Times Of the Pulses

We’re now ready to measure the times of arrival of the pulses. First, we record the data from several screen scans to analyze the data in a separate graphic analysis window.


1. Turn off the receivers with the mode switch and verify that the three receivers are set to get data at 400, 600, and 800 MHz simultaneously with the horizontal seconds set at 4 and the vertical gain at 4 in each receiver.

2. Click on the record button to enable the data recorder, and then turn the receivers on with the mode switch.

3. Let the receiver scan for five or six screens worth of data (only the first 4 will be saved). Then switch off the receivers.
· The computer will tell you that 1600 data points have been saved.
· It will then show you the name of the object for verification. Click OK.
· A pop up a screen will appear showing you information about the object you just recorded, including the time when the recording began (in Julian days—a running date), the frequencies, and the time between each sample of the signal. See FIGURE 8 below.
· [image: ]You cannot edit this data. This screen is for information only.




Figure 8
Data Properties Pop-Up Screen






4. Click on OK. The computer will then ask you if you want to save the data or analyze it immediately. Click on Yes, and the computer prompts us for a file name. (If you choose No, do not worry. The most recent data is stored in memory and can be analyzed.) It will make one up using the name you logged in with. If you want to change this name, you can do so. Record the name of the file you have created in the space provided:

FILE NAME	.

Having saved the data in a file, let’s now analyze it.

5. First close the receivers by clicking on the x in the upper right corner of the main receiver window.

6. In the main window, select Tools > Radio Pulsar Analysis. If you have not turned off VIREO, a window should appear showing you the general information on the data file you just created (otherwise, it will ask you to use the File > Load menu to choose from a menu of data files by name.)

7. You will see a measuring window with the three traces labeled. This is similar your three receivers, but it displays the stored data you just received.
· You can set down measuring lines, and scroll back and forth in the display at your leisure.
· Experiment with using the horizontal pan buttons, which move the traces right and left.
· Experiment with the zoom in and zoom out buttons, which magnify the scale of the traces.

8. Now let’s measure the times of arrival of a pulse at the three different frequencies you recorded. Use the Horz Zoom controls to zoom in until you can see about two pulses across the screen. This high magnification will let you measure the pulse arrival times more readily. Pan the screen so that there is a pulse at 400 MHz in the right half of the top screen.


You should see the same pulse arriving earlier (to the left, at an earlier time) at the 600 MHz frequency, and still earlier (even further to the left) at the 800 MHz frequency.

9. Now let’s measure. Holding down the left hand mouse button while you’re moving the mouse in a measuring window will move a vertical line back and forth across the screen. Set one line in the middle of the 400 MHz pulse. You can read the time of arrival in the blue window to the right of the measuring window. Set measuring lines similarly in the 600 MHz and 800 MHz windows.

10. Record the times of arrival of the pulse at the three frequencies T400 , T600 and T800 on the table below.

PULSAR 0628-28 Dispersion Data

T400  	 sec

T600  	 sec

T800   	 sec

11. Now, using the dispersion formula for radio waves described above, use the difference in arrival times at two different frequencies to calculate the distance to the pulsar. (Since there are three different pairs of frequencies, you can calculate this three ways, just to check you’re doing it right.

PULSAR 0628-28
[bookmark: Dispersion_Distance_Analysis_]Dispersion Distance Analysis
	Frequencies (MHz)
	
T2 – T1 (sec)
	(1/f2)2 – (1/f1)2
			D (pc)

	f1
	f2
	
	
	

	600
	400
	
	
	

	800
	400
	
	
	

	800
	600
	
	
	



If you’ve not made any numeric mistakes, your three distances should agree to at least two significant figures, and should be of the order of 1000 parsecs or so. Check over your work and your measurements if there’s some disagreement.

Part 5: Determine the distance of Pulsar 2154+40 applying the techniques you have just learned.

Let’s determine the distance to the pulsar, 2154+40 (the pulsar is on the Hot List). Using the radio telescope, locate the pulsar. Record the data at three frequencies of your own choice and save it. Analyze the data to determine the distance of the pulsar. The following tables will help you organize and analyze your data.
File Name Of Data on 2154+40	. Frequencies Used (MHz)

1.  	

2.  	

3.  	


Pulsar 2154+40 Dispersion Data

Tfreq 1 	 sec

Tfreq 2 	 sec

Tfreq 3 	 sec


Ask your instructor if the above times are reasonable. Are you using the correct pulses?

[bookmark: PULSAR_2154-40_]PULSAR 2154+40
Dispersion Distance Analysis
	Frequencies (MHz)
	T2 – T1 (sec)
	(1/f2)2 – (1/f1)2
	D (pc)

	f1
	f2
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	



Additional Optional Exercises You Can Do With This Telescope

1. The Distance To Short-Period Pulsars

Measure the distance to the Crab Nebula and to Pulsar 0740-28 using the dispersion method. You can use the method you have learned in this exercise - but be careful not to lose track of which pulse is which! You must identify the same pulse at each frequency. (Hint: Try tuning all three receivers to the same frequency and gradually re-tune receivers number two and three in small increments, 10MHz or less, keeping track of the pulse as you do so.)

2. Measuring the Telescope Beam width

We simply measure how long it takes for the pulsar signals to decrease by half when the telescope tracking is turned off. Over a minute or so, you will see the signal strength of the pulses slowly decrease. Since the earth turns a degree every 4 minutes, you can calculate, from this time, how far the pulsar was from the center the telescope was pointing at (in degrees) when its received signal strength declined to the “half power” value. This is 1/2 of the “half-power beam width” of the telescope (the factor 1/2 comes from the fact that the HPBW is measured both sides of center.)

Procedure
· Choose a strong pulsar with a relatively short period such as 0740-28.
· Point the telescope at the pulsar and make sure the tracking is on.
· Turn on the receiver and adjust the vertical gain so that the average pulsar signal peaks at a value of about half the height of the screen. (The peak heights vary randomly, so you’ll have to judge this by eye.)
· Then turn the tracking off and record the time (on a watch) when you did this. Time Tracking turned off:	.


· Watch carefully and by eyeball estimate the time when the signal reaches half its original value. You can then turn the tracking back on.

Time signal reaches half of original value.	_.

· Use these values to calculate the half-power beam width in minutes of arc. (60’ = 1o ).
· Half-power beam width  	

3. Measuring the Pulsar Spin-Down Rate

Pulsars slow down with time because they lose energy. You can measure this effect with this telescope, although the details of the method are too elaborate to describe here. The basic idea is to measure the period at one time (which you can set using the Files > Set Observation Date/Time) command, and then measure the period at a later time. You need extremely high precision (about one part in 1015) to measure the spin-down rate. So the two dates you observe must be separated by a year or two to make it possible to detect the cumulative effect of the small changes. In addition, at each of these two dates, you need to take an average of many tens of thousands of pulses to get the periods of the pulsars precisely enough. This can only be done by observing the precise pulse arrival times several days apart, and calculating the number of pulses that have occurred between the two observations. Your instructor can provide a complete write up for this experiment if he wishes you to perform this experiment.

4. Searching for Pulsars

The radio telescope can be operated as a “transit” instrument—with the tracking motor off you can let the earth move the telescope around the sky, and watch pulsars as they come into and out of view. If the beam width of the telescope is too small, it will take a long time to find pulsars this way, since it will take a long time to scan the whole sky. But your instructor can set the telescope so it has a large beam width, and you can try to find as many pulsars as you can. This can be a long-term project, since it will take more than a short lab period. Over 500 pulsars are included in the catalog for this telescope. Once you know the rough coordinates of the pulsars, you can plot them out on a map. Are the pulsars concentrated in any particular part of the sky? What is the significance of the distribution?
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